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Alzheimer’s disease (AD) is a prominent 
neurodegenerative disorder (NDD) affecting the aging 
population. Of the 6 million people affected, 2/3rds are 
women. Evidence suggests women are more susceptible 
to AD due to a variety of social stress factors, differences 
in immune response, and a decline in estrogen levels. 
Notably, estrogen levels are prolonged in pregnancy and 
offer protection against neurodegeneration. However, the 
cellular mechanism for this protection remains unclear. 
This study aims to understand the impact of pregnancy 
on mood, cognition, and microglia function in Alzheimer’s 
disease mice. We hypothesized that pregnancy would 
decrease the levels of the biological hallmarks of AD, 
therefore reducing anxiety-like behaviors and improving 
cognition. To test this hypothesis, we used control and 
AD mice between the ages of 7-8 months. The mice were 
run through a behavior paradigm to measure anxiety-
like behavior and memory. Immunohistochemistry 
was used to stain for amyloid plaques and microglia. 

Introduction

The central nervous system (CNS) consists of the brain and spinal 
cord. Together, they can sense, integrate, and direct our behavior (Thau 
et al., 2025). The brain senses our environment through touch, vision, 
audition, olfaction, and taste and converts this sensory information 
into a chemical signal sent through neurons that the brain can then 
interpret (Nervous System, 2023) (Figure 1). Essentially, it is the brain 
that coordinates the release of neurotransmitters and hormones which 
influences our behavior, emotion, and cognition. At the outermost layer 
of the brain is the cerebral cortex, which is divided into four lobes—the 
frontal, parietal, occipital and temporal lobe (Thau et al., 2025). The frontal 
lobe is typically associated with voluntary motor function, problem-solving, 
attention, memory, and language (Thau et al., 2025). Sensory information is 
then processed in the parietal lobe (Jawabri & Sharma, 2025). Responsible 
for processing visual information is the occipital lobe. The temporal lobe 
is associated with processing auditory stimuli (Jawabri & Sharma, 2025). 
Within these four lobes there are other important structures such as the 
thalamus, hypothalamus, and hippocampus (Torrico & Abdijadid, 2025). 
The thalamus is the brain’s relay center that receives information from 
sensory receptors throughout the body and sends that information to the 
appropriate cortical area (Torrico & Abdijadid, 2025). Additionally, it can also 
regulate consciousness and sleep. Connecting the CNS to the endocrine 
system is a small structure known as the hypothalamus: this small structure 
controls heart rate, blood pressure, appetite, and the release of various 
hormones among other functions (Thau et al., 2025). The hippocampus 
resides in the temporal lobe and is associated with memory encoding, 
consolidation, retrieval, and decision making. This curved structure has 
three zones—the dentate gyrus (DG), the Cornu Ammonis (CA), and 
the subiculum (Fogwe et al., 2025) (Figure 2). Within the hippocampus 
are subfields CA1, CA2, CA3, and CA4, where CA2 and CA3 border the 
hilus of the DG (Fogwe et al., 2025). Alongside other temporal structures 
of the brain, these hippocampal structures work together in memory 
formation in three steps: registration, storage, and retrieval of information 
(Fogwe et al., 2025). This seahorse-shaped region of the brain essentially 
holds a key to our memories and creates new memories as we age. 

Aging is defined as the time-related accumulation of molecular 
and cellular damage that can lead to the gradual decrease in physical 
and mental capacity (Gilbert, 2000, Ageing and Health, 2025).  Although 
there are a variety of lifestyle factors that can impact aging, around 40% 

of individuals will experience some form of age-associated memory loss 
after 65 years of age while 5 to 8% will live with dementia (The Differences 
between Normal Aging and Dementia, 2024). Age-associated memory loss 
will not significantly disrupt daily life, but dementia can. Dementia is an 
umbrella term for symptoms related to behavior and cognitive function that 
are due to specific diseases (Dementia vs. Alzheimer’s Disease, 2025). 
Specifically, Alzheimer’s disease (AD) is known to account for 60-80% of 
dementia cases (CDC, 2025). AD is a NDD that is typically associated 
with behavioral and cognitive decline that can progressively worsen 
(Alzheimer’s Disease Fact Sheet, 2023). Initially, AD can present itself with 
forgetting information that was just read, misplacing an object, and difficulty 
with planning and organizing (Alzheimer’s Disease Fact Sheet, 2023). 
As the disease progresses, individuals can lose awareness of recent 
experiences, have difficulty communicating, and can require constant 
assistance during daily life (Alzheimer’s Disease Fact Sheet, 2023). Given 
that AD can severely impact daily life throughout its progression, it is 
important to explore factors which can protect against the disease as well 
as gain insight into how the disease presents itself at the cellular level. 

Figure 1. The Central Nervous System and Neuron (Nervous System, 
2023). The nervous system is composed of the CNS and peripheral nervous system. 
The CNS consists of the brain and spinal cord. The primary unit of the CNS in the neuron. 

Figure 2. Human and rodent hippocampal divisions. The hippocampus 
and corresponding division in humans (top) and rodents (bottom) (Roux et al., 
2021). Abbreviations: EC: entorhinal cortex; MF: mossy fibers; PP: perforant 
path; SC: schaffer collateral; RC: recurrent collaterals; SUB: subiculum
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AD is the leading cause for dementia (Dementia, 2025). 
Notably, it impacts around 6.9 million Americans, with two-thirds of that 
population being women (Alzheimer’s Association, 2024; Alzheimer’s 
Disease Facts and Figures, 2025). Women are often noted to have a 
greater susceptibility to developing AD due to a variety of social stress 
factors, differences in immune response, and a decline in estrogen 
levels (Moutinho, 2025). Notably, women also experience specific 
life events such as pregnancy and menopause (Barth & de Lange, 
2020). These events are characterized by physical, emotional, and 
physiological changes that can have life-long impacts (Orchard et al., 
2023). Specifically, pregnancy has shown to impact a woman’s cognition 
and inflammatory response which is noted to coincide with an increased 
in estrogen levels (Barth & de Lange, 2020; Kepley et al., 2025). Given 
that pregnancy alters the immune response and has similar physiological 
changes to an AD brain, the gradual cognitive renormalization pregnancy 
provides could provide insight into the molecular representation of AD.    

Pregnancy involves biological and social changes; it is described 
as a period where a fetus develops in the uterus and consists of various 
physiological transformations (About Pregnancy | NICHD - Eunice Kennedy 
Shriver National Institute of Child Health and Human Development, 2024). 
This dynamic period in a woman’s life creates a challenging environment 
that promotes cognitive reserve and emotional adjustments to care for 
newborns (Orchard et al., 2023; de Lange et al., 2019). The researchers 
note that a challenging environment is seen in the increased cognitive load 
that caring for a child during their infancy, toddlerhood, early childhood, 
adolescence and adulthood stages of life brings (Orchard et al., 2023). 
Cognitive reserve refers to the idea that individual differences in the neural 
networks that help complete a task can provide reserve against brain 
pathology (Hindle et al., 2014; Stern, 2006).  Here, the brain compensates 
using alternate networks and can modulate the clinical representation 
of AD pathology. During pregnancy, postpartum, mid-life and late life, 
women are exposed to a demanding environment and increased cognitive 
load that requires continuous adaptations (Orchard et al., 2023) (Figure 
3). Women often report experiencing cognitive decline during early 
motherhood (Davies et al., 2018). These are often self-reported declines 
in concentration and feelings of absentmindedness. In a study involving 
709 pregnant women, significant reductions in cognitive function, memory, 
and executive function were reported when compared to nulliparous 
women (Davies et al., 2018). At this time, there are also physical changes 
in the brain that occur, like decreased grey matter during pregnancy and 
renormalization of parietal grey matter in the postpartum period (Davies 
et al., 2018). An MRI study examined 25 female adolescents with no 
reproductive history and 20 adult first time mother and showed that in 
both cases, the adolescent girls and mothers experienced a volumetric 
reduction in cortical thickness and surface area (Carmona et al., 2019). 
These findings were consistent with the hormonal changes that occur 
during adolescence and pregnancy (Carmona et al., 2019). Similarly, a 
study that included 12,021 middle-aged women showed that parous 
women had less brain aging compared to nulliparous women (de Lange 
et al., 2019). Despite reporting subtle cognitive decrements and lower 
grey matter in the brain—women exhibit characteristics of decreased brain 
aging (Davies et al., 2018). Rodent literature also suggests that there is 
some cognitive decline during the final week of pregnancy, which would 
correspond with the third trimester of human pregnancy (Darnaudéry et al., 
2007; Galea et al., 2000). Similar to humans, rodents showed a volumetric 
reduction in brain size and cellular changes (Hillerer et al., 2014). Male 
and female rats, with or without a breeding history, exposed to a stress-
inducing paradigm demonstrated changes in neurogenesis which were 
measured through dendritic pruning and spine density changes (Hillerer 
et al., 2014). The study noted that neurogenesis increased during the 
peripartum period—specifically in the DG of the hippocampus (Hillerer et 
al., 2014). When comparing parous rats to middle-aged nulliparous rats, 
a reproductive history was associated with increased neurogenesis (Eid 
et al., 2019). During the transition to pregnancy, and later to postpartum, 
the associated reproductive hormones can impact behavioral, emotional, 
and cognitive responses (Trifu et al., 2019). Changes in reproductive 
hormones such as estradiol, progesterone, and cortisol during pregnancy 
are also associated with psychiatric disturbances (Trifu et al., 2019).  

Furthermore, the immune response could act as a link between 
pregnancy and AD, although it is understudied (Fox et al., 2018). During 
pregnancy, a woman’s immune response improves and is noted by the 
protective window the rise of estrogen provides (Fox et al., 2018; Robinson 
& Klein, 2012)we investigate the relationship between pregnancy and 
AD.\n\nMethods:\nCross-sectional cohort of British women (N = 95. This 
protective window is believed to support the cognitive renormalization 
that occurs during the postpartum and late-life period in a woman’s life 
(Fox et al., 2018). Notably, AD exhibits an impaired immunoregulatory 
response which is believed to worsen pathology biomarker, like plaques 
and tangles. (Fox et al., 2018; Town et al., 2005). Current research lacks 
an understanding of the role of immunoregulation during pregnancy 
and how the hightened inflammatory response during this time offers 
neuroprotection which is not seen in AD (Pregnancy History May Be 
Linked to Dementia – Alzheimer’s Society Comment | Alzheimer’s Society, 
2018). Here, we predict that looking at the pathological markers of AD, 
immune related cells like micrgoglia, and behavior changes in an AD 
rodent model, could provide insight in neuroportection after pregnancy.

Figure 3. The life-long impact of pregnancy and motherhood 
(Orchard et al., 2023). 

Neuropsychiatric symptoms and cognition in Alzheimer’s disease 

Notably, neuropsychiatric symptoms (NPSs), such as anxiety and 
depression are associated with accelerated AD pathology and are often 
observed to a greater extent in women (Lyketsos et al., 2011). Specifically, 
anxiety has been reported to act as a better predictor of AD progression 
and has been associated with increased amyloid burden (Hunsberger 
et al., 2024). Currently, NPSs are considered an early biomarker for 
AD progression instead of just a risk factor, indicating their significance 
in modifying disease progression (Donovan et al., 2018). However, it is 
still unclear how NPSs mechanistically impact AD and whether their 
manifestation and symptomatology differ between men and women 
(Hunsberger et al., 2024). Interestingly, there is human and rodent data 
suggesting that neuroinflammation can influence AD pathology when 
present alongside NPSs (Holmgren et al., 2014). The immune cells of the 
brain, primarily microglia, detect neuronal stress such as amyloid burden 
and increase the production of cytokines and oxidative stress (Holmgren 
et al., 2014. This defense mechanism can worsen pathology from an 
unregulated release of interleukin (IL)-1, leading to neuronal death. On 
the other hand, microglia can also release anti-inflammatory cytokines 
that protect against neuronal death and increase the phagocytosis of 
amyloid beta (Aß) plaques (Holmgren et al., 2014). Interestingly, these 
inflammatory mediators have been reported to play a role in NPSs 
encountered during AD progression (Eikelenboom et al., 2002). Cytokine 
production, like that in neuroinflammation, can modulate psychological 
stress, neuroplasticity, and neural circuitry involved in mood (Salim et 
al., 2012). Therefore, the dysregulation of immune signaling can result 
in anxious behavior, depressive behavior, and cognitive dysfunction. 
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Anxiety is one of the most common NPSs in individuals with AD 
(Lyketsos et al., 2011). It is typically associated with brain structures 
like the hippocampus, amygdala, and prefrontal cortex (N. K. Zhang 
et al., 2024). There is a positive correlation between anxiety and Aß 
burden which highlight its importance in disease progression. In human 
studies, higher levels of anxiety were associated with advanced brain 
aging (Han et al., 2021). There is a positive correlation between anxiety 
and Aß burden which highlight its importance in disease progression. In 
humans, approximately 50% of patients exhibit anxious behavior (Várkonyi 
et al., 2022). Therefore, using rodent models to understand this NPS is 
essential to AD research (Várkonyi et al., 2022). Biological brain aging was 
measured through methods like omics data (e. g. epigenetic clocks) and 
clinical biomarkers like blood chemistries (Várkonyi et al., 2022). Positron-
emission tomography (PET) studies further confirm the positive associations 
between anxiety and Aß deposition, yet there are still some inconsistencies 
in the data as amyloid burden does not necessarily correlate with cognitive 
decline (Várkonyi et al., 2022).  Therefore, the use of behavior testing on 
rodents can allow researchers to explore these complex behaviors (van 
Meer & Raber, 2005)the laboratory mouse (Mus musculus. In AD rodent 
models, behavior testing is used to measure anxious behavior, depressive 
behavior, and cognition (Zhong et al., 2024). Mice are exploratory animals, 
therefore anxiety-like behaviors are seen through avoidance of areas or 
latency to approach areas, repeated behaviors, decreased movement, 
and thigmotaxis (staying near the edges) (Pietropaolo et al., 2012). These 
behaviors are assessed using the open field (OF), marble bury (MB), 
and novelty suppressed feeding (NSF) tests. Transgenic (Tg) AD mouse 
models such as the APP/PS1 model exhibit decreased social investigation, 
indicating withdrawal-like behavior (Pietropaolo et al., 2012). Anxiety-like 
behaviors in mice are defined through motivated behavior that is elicited 
through exposure to a potentially harmful context (Pentkowski et al., 2021). 
Research exploring the impact of anxiety on the 3xTg AD model, which 
has both tau and amyloid,  noted that mice at 4-, 6-, and 8- months of 
age exhibited less movement in the OF and groomed themselves more 
often than the control group (Várkonyi et al., 2022). Similarly, AD mice 
exhibited anxiety-like behavior through significant decreases in the number 
of entries into the open arms of an elevated plus maze and significantly 
less time spent in the light side of the light-dark test (Zhang et al., 2016). 
All together these results imply that anxiety is a prodromal symptom of AD. 

Depression can also play a role in disease progression, both in 
humans and rodents. Typically, depression is associated with alterations 
of glutamatergic synaptic transmission, neuroinflammation, and atrophy 
in the hypothalamic-pituitary-adrenocortical (HPA) axis and hippocampus 
(Dolotov et al., 2022). There are changes in nerve and glial cells which 
can lead to neurodegeneration and cause brain pathologies to increase. 
Similar to pregnancy, depression can lead to reduced gray matter volume 
and cortical thickness depending on severity (Brommelhoff & Sultzer, 
2015). Additionally, a loss of hippocampal serotonergic neurons and 
abnormal fatty acids in the prefrontal cortex indicate demyelination in the 
hippocampus (Lai et al., 2011; Luo et al., 2022; Nihonmatsu-Kikuchi et al., 
2013). To assess depressive-like behavior in rodents, the OF test, elevated 
plus maze task, and forced swim test are often used. When investigating 
depressive-like behavior in mice using the OF test, researchers noted 
increased depressive-like behavior in AD mice as indicated by less time 
moving when compared to the control group (Frye & Walf, 2009). Similarly, 
in the OF test, AD mice were seen to have significantly reduced travel 
times, reduced number of entries in the center, and less time spent in 
the center when compared to the control group (M. Zhang et al., 2023). 
Interestingly, behavioral tests done prior to Aß plaque deposition in AD 
mice indicated behavioral and cognitive differences (Martín-Sánchez 
et al., 2021). Here, AD mice had a higher percentage of immobility 
compared to control mice. The appearance of anxious and depressive-
like behavior can also impact cognition and was indicated by a greater 
latency to reach a platform in AD mice compared to the control group.

Neuropsychiatric symptoms and cognition during pregnancy

Throughout pregnancy and postpartum, there are various fluctuations 
in reported mood and cognition for women. Pregnancy places women in 
a vulnerable state, making them more sensitive to stressors and stress 

related disorders (Pawluski et al., 2011). After pregnancy, around 15% of 
women worldwide develop postpartum depression and can experience 
other mood disorders during pregnancy (Pawluski et al., 2011). Additionally, 
an estimated 10-20% experience anxiety and depression, factors which 
are associated with detrimental effects on the mother (Pawluski et al., 
2011). These mood disorders can create stress for mothers, further 
increasing anxiety-like behaviors. Although anxiety can exist independent 
of depression, anxiety holds an 85% comorbidity with depression (Brunton 
et al., 2015). Similarly, pregnant female rats also display increased 
anxious behavior when measured on the EPM (Neumann et al., 1998). 
After parturition, though, female rats exhibit decreased anxious behavior. 
Interestingly, there have been studies aiming to understand whether 
parous rodents allocate care preferentially to female or male pups, but 
results remain inconclusive (D’Amato et al., 2006). Additionally, a woman’s 
cognition is altered during pregnancy (Brett & Baxendale, 2001). Studies 
examining the subjective experience of subjective and cognitive changes 
during pregnancy report that women have increased forgetfulness, 
confusion, disorientation, and poor concentration (Brett & Baxendale, 
2001). Additionally, pregnancy is marked by fluctuations in hormones that 
can impact memory like oestrogens, progesterone, glucocorticoids, and 
oxytocin. Oestrogens include estrone 1 (E1), estradiol (E2), and estriol 
(E3) which all show an increase in plasma level during pregnancy (Brett 
& Baxendale, 2001). A majority of the oestrogen receptors (ERs) are in 
the hypothalamus while the hippocampus and the basal forebrain are 
known to have lower ER densities. Despite a reported cognitive decline 
during pregnancy, a higher number of cumulative months pregnancy is 
associated with a lower risk for the development of AD (Fox et al., 2018). 
Mainly, a woman’s reproductive history has shown to play an important 
role in modifying their inflammatory response through the prolonged 
estrogenic exposure (Fox et al., 2013) (Figure 4). These data demonstrate 
that pregnancy can place the brain in a challenging environment which can 
potentially protect the brain against dementia, and dementia-like disorders.

Figure 4. Higher cumulative months pregnant and probability of 
developing AD. More cumulative months pregnant is associated with a lower risk 
of developing AD. A Cox regression reported that women who were above the cohort 
median exhibited a 37.01% lower risk of developing AD when compared to women 
below the median (ß=-.99. exp(ß)=.40, P=.01, (5% CI =.17-.81) (Fox et al., 2018). 

Neurodegeneration in Alzheimer’s disease

As mentioned briefly before, biologically, AD is characterized 
by amyloid plaques, neurofibrillary tau tangles, and neuroinflammation 
(Parhizkar & Holtzman, 2022). Behaviorally, AD is characterized by cognitive 
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decline, mood changes, and motor dysfunction depending on the brain area 
that is impacted (Peña-Bautista et al., 2020). Factors such as stress and 
the subsequent neuroinflammation can play a role in disease progression, 
although the specific mechanism remains understudied (Peña-Bautista et 
al., 2020). The neurodegenerative progression is both a psychologically 
and physiologically stressful event. Individuals tend to present with aberrant 
emotional and aggressive behavior as more neurons are lost and neuronal 
circuits mediating stress responses are disrupted (Justice, 2018). Structures 
such as the hippocampus exhibit amyloid plaque and tangle pathology 
even in the early stages of AD and mild cognitive decline (Pentkowski 
et al., 2021). These key characteristics were initially discovered by Alois 
Alzheimer in 1901, where he noted aggregation of those abnormalities 
in a 50-year-old female patient (Jeong, 2017; Lopez-Lee et al., 2024).

The cleavage of the amyloid precursor protein (APP) by alpha-, 
beta-, and gamma secretases lead to either soluble or insoluble product 
(Simunkova et al., 2019). When APP is cleaved by alpha secretase, 
a soluble p3 fragment is formed, on the other hand cleavage via beta 
secretase results in an insoluble Aß fragment (Simunkova et al., 2019). 
In both cases, gamma secretase functions to isolate the product of either 
secretases (Simunkova et al., 2019) (Figure 5).  Mainly, the Aß42 form is 
deposited in the brain and is the most toxic product of beta secretase, with 
its hydrophobic and fibrillogenic nature (Murphy & LeVine, 2010; Parodi-
Rullán et al., 2019; What Happens to the Brain in Alzheimer’s Disease?, 
2024). This toxic form only accounts for around 10% of the enzymatic 
process, while the other 90% is accounted for by alpha secretase (Murphy 
& LeVine, 2010). Clearance of these amyloidogenic deposits occurs 
through various mechanisms. These mechanisms include the blood-
brain barriers, interstitial fluid, cerebrospinal fluid absorption-mediated 
pathways, most important to this project, glial cells (Ullah & Lee, 2023). 

Figure 5. Amyloid precursor protein (APP) secretase 
pathways (Hampel et al., 2021). APP cleavage through alpha 
(ADAM9, 10, or 17) secretase (left) or beta (BACE1) secretases (right).

Immune response in Alzheimer’s disease 

Recently, inflammation has emerged as a vital player in the 
progression of AD with microglial activation acting as a key element 
(Kinney et al., 2018). Specifically, neuroinflammation refers to the 
inflammatory response within the CNS that is used by various pathological 
insults like infection, trauma, and toxins among others (Kinney et al., 
2018). In neurodegeneration, this initially protective response can become 
unregulated and lead to neurodegeneration (Heneka et al., 2015) (Figure 
6). Inflammation in the brain is typically measured via pro-inflammatory 
cytokines (IL-1ß, IL-6, IL-18), tumor necrosis factor (TNF) and reactive 
oxygen species by innate immune cells (Leng & Edison, 2021) (Figure 
7).  The release of these pro-inflammatory molecules is associated with 
synaptic dysfunction, neuronal death, and the reduction of neurogenesis 
(Leng & Edison, 2021). This response is followed by the activation of 
microglia to their phagocytic state, which if left unregulated, can result in 
the early pruning of synapses (Leng & Edison, 2021). On the other hand, 
there are also anti-inflammatory cytokines which regulate this inflammatory 
response (Kwon & Koh, 2020). Post-mortem AD brains confirm the chronic 

inflammatory response with the appearance of microglial connections to 
activated plaques in immunohistochemical analysis (Kwon & Koh, 2020).

The role of microglia: Healthy versus disease

Microglia are considered the resident immune cells of the CNS and 
hold an extensive role from birth to death (Borst et al., 2021). Accounting 
for 10% of the CNS cell population, they play a vital role in processes 
such as neurogenesis, neuronal plasticity, and regeneration, and are at 
the front line of the immune defense response for a variety of injuries 
(Calsolaro & Edison, 2016). The many functions microglia carry can be 
attributed to their variety in morphology (Vidal-Itriago et al., 2022). To 
study the diverse microglia morphology, research has distinguished 
microglia based on their morphology, density, and electrophysiological 
properties. Importantly, there is a lack of understanding in how the 
structure and function of microglia manifests (Vidal-Itriago et al., 2022). 
Furthermore, differences in microglia between females and males 
adds to the complexity of microglia structure and function. Specifically, 
steroid sex hormones, like estradiol, which exist differently in females 
and males can reduce inflammatory potential (Villa et al., 2016). 

With regard to structure, microglia exhibit diverse morphologies 
that can provide insight into the physiological role they play (Vidal-Itriago 
et al., 2022). The different microglial states include a ramified, hyper-
ramified, and amoeboid among others (Vidal-Itriago et al., 2022). Usually, 
a ramified state is considered the ‘resting’ state of microglia. This state is 
characterized by a high number of branching with primary and secondary 
branching and aid to help surveil nearby areas. The hyper-ramified state 
has extensive branching and is typically seen in acute and chronic stress 
models. The amoeboid microglia have a rounded morphology which 
is correlated to its high phagocytic and migratory capacity. Research 
to quantify the different microglia morphologies indicate that microglia 
morphology is affected by different environments (Martinez et al., 2022). 
Here, neuron-glia cultures were treated with a control substance and 
N-methyl-D-aspartate (NMDA) treatment to mimic cell death like that seen 
in ischemia (Martinez et al., 2022). The researchers found that in NMDA 
treated cultures had significantly more cell debris, an indicator of cell 
death. These NMDA treated groups also exhibited a significantly greater 
number of hypertrophic morphology when compared to the control group. 
With the addition of lipopolysaccharide (LPS) to trigger inflammation, the 
cell cultures had significantly less hypertrophic morphology. Furthermore, 
microglia are classified into a classical (M1) or alternative (M2) state 
(Guo et al., 2022). The M1 pathway is associated with proinflammatory 
responses which include the release of several cytokines that are 
neurotoxic (Guo et al., 2022). The M2 pathway then regulates M1 through 
the release of anti-inflammatory cytokines and growth factors which help in 
regulating synaptic strength and plasticity (Guo et al., 2022). Interestingly, 
during disease, microglia can hold both M1 and M2 characteristics. 

The aging and diseased brain can provide insight into the structure 
and function of microglia (Tremblay et al., 2012). Research has shown that 
the aging brain is characterized by cellular changes to neurons and glial 
cells (Tremblay et al., 2012). Interestingly with age, microglia increase in 
number, become irregularly distributed, and exhibit variable cell bodies, 
branching, and morphologies (Tremblay et al., 2012). Specifically, Iba1-
labeled microglia changed in density, distribution, and morphology during 
aging. Microglia in older mice decrease in process arborization, between 12 
months and 24 months of age. Furthermore, research using social isolation 
as a stress model notes that microglial branching could provide insight into 
the functional role of microglia based on morphological change (Ferrara et al., 
2022). Here, isolation appeared to increase microglia skeleton complexity 
in adolescent rats while decreasing in adult rats, with similar findings in 
total process length in adolescent and adult rats, respectively. Although 
stress has been shown to impact microglia morphology, there is a lack 
of research investigating the impact of pregnancy on microglial activation 
in mothers (Ferrara et al., 2022). Therefore, understanding how microglia 
morphology changes throughout disease progression in parous female 
rodents could provide meaningful insight into microglia function in the brain. 
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In summary, pregnancy and postpartum are noted to act as a 
protective barrier against AD. Despite the neuroprotective impact, the 
underlying pathogenic mechanism which disproportionately impacts 
more women than men is not well understood (Kommaddi et al., 2021). 
Additionally, the interaction between prolonged estrogen levels after 
pregnancy, its neuroprotective factors on plasticity and inflammation in the 
hippocampal DG provide a crucial opportunity to further the understanding 
of the impact of pregnancy on AD pathogenesis (Kommaddi et al., 
2021). In this study, we hypothesize that pregnancy will protect against 
anxiety-like behaviors, cognitive decline, and amyloid pathology, while 
also reducing overall microglia number but increasing branch length. 

	  

Figure 6. Microglial activation in the presence of plaque pathology 
(Heneka et al., 2015)

Figure 7. Microglial dual activation, from healthy to disease (Leng & 
Edison, 2021)

Materials and Methods

Mice
In this study, Mline, 129s6, ArcCre-EYFP (Control), and APP/

PS1 (AD) were used. Mice were group housed (3-5/cage) and had 
ad libitum access to food and water. Both female and male mice 
were used in all experiments. All procedures were conducted in 
accordance with the Institutional Animal Care and Use Committee 

(IACUC) at Rosalind Franklin University of Medicine and Science. 

Experimental Cohorts

There were a total of eight groups in this study: 1) Nulliparous control 
female (n=8), 2) Nulliparous AD female (n=6), 3) Parous control female 
(n=8), 4) Parous AD female (n=8), 5) Virgin control male (n=6), 6) Virgin 
AD male (n=6), 7) Sire control male(n=13), and 8) Sire AD male (n=6). 

Behavior testing

Mice were run through open field, marble burying, novelty 
suppressed feeding, and contextual fear conditioning at 30-
35 weeks of age post pregnancy or naive. All mice underwent 
all tests. Experimenters were blind to genotype and groups. 

Behavioral Timeline

Figure 8. Week-long behavioral paradigm

Open Field (OF) 

The OF test was used to measure avoidance and exploratory 
behavior. Mice were placed in an open arena and were allowed to 
explore for 10 minutes. Ethovision was used to record each trial. 
Time spent in the periphery and center was measured. Between each 
trial, the floor and walls were cleaned using 70% ethanol and dried.

Marble Burying (MB)

The MB assay was used to measure perseverative behavior in 
mice. Each mouse was placed in a holding cage containing an adequate 
amount of bedding so that the floor of the cage was not visible. 16 
marbles were arranged in a four-by-four grid in each cage. Mice were 
left undisturbed in the holding cage for 20 minutes, after which they 
were removed and placed in their home cages. Afterwards, the number 
of marbles covered 50% by bedding were counted and recorded.

Novelty Suppressed Feeding (NSF)

NSF was used to measure hyponeophagic behavior, or the 
motivation to approach food in a bright novel arena. Prior to the testing 
day, mice were fasted for 18 hours with proper food restriction diet cards on 
their home cages. Mice were weighed once food was taken away. After 18 
hours, day 2 weight was recorded to endure fasting, and the NSF testing 
apparatus was prepared. The apparatus consisted of a white plastic box 
measuring 50 x 50 x 20 cm and covered with about 2 cm of bedding. Light 
fixtures were set to surround the arena at approximately 1000 lux. In this 
testing apparatus, a single food pellet was placed at the center. As soon as 
a mouse was placed in a corner of the apparatus, a stopwatch was started. 
Time was recorded to measure the latency of the mouse to approach the 
food. Once back in the holding cages, a pre-weighed food pellet was placed 
in the cage. Latency to approach the food was measured. The mice were 
allowed to eat for five minutes, afterwards the pellet was weighed again. 

Contextual Fear Conditioning (CFC)

All mice were run through CFC to measure memory impairment. The 
chambers used in this paradigm were obtained from Actimetrics (Lafayette, 
Indiana) and measured at 7.4” L, 8.1” D, and 7.9” H. The chamber had 
clear walls, a stainless-steel barred floor, and a house light (CM1820 bulb, 
28 v, 100 mA). Chambers were inside of a larger plastic chamber which 
was insulated to protect against outside light and noise. A paper towel was 
dabbed with five blots of a lemon scent (Pure Lemon Extract; McCormick®; 
Hunt Valley MD) using a cotton tip and placed underneath the floor of the 
chamber. A 3-shock CFC paradigm was used with one .75mA shock occurring 
at 180s, 240s, and 300s. Mice spent a total of five minutes in the chamber. 
Five days after the initial CFC paradigm, mice were exposed to the same 
chamber and lemon scent without shocks. All sessions were recorded using 

Eukaryon Volume 225



Eukaryon, Vol. 22, March 2026, Lake Forest College Senior Thesis

	

the FreezeFrame4 software. Freezing (%) was used as a proxy for memory. 

Sections and Tissue 

24 hours before sacrifice, mice were intraperitoneally (i.p.) injected 
with Methoxy-04 to tag amyloid plaques. Mice were then anesthetized 
using an i.p. injections of a (R, S)-ketamine/xylazine mixture (Ketaset 
III, Ketamine HCl injection, Fort Dodge Animal Health, Fort Dodge, Iowa 
100mg/kg / 10mg/kg) after CFC re-exposure. Mice were transcardially 
perfused using 1X PBS followed by 4% paraformaldehyde (PFA). Brains 
were removed and stored in 15mL conical tubes containing 4% PFA 
for 24 hours. After 24 hours, they were switched into a 30% sucrose 
solution for long-term storage. Brain tissue was sections coronally using 
a vibratome set at 50μm and stored in 1X PBS with 0.1% sodium azide. 

Immunohistochemistry

A minimum of three dorsal and three ventral sections were chosen 
per mouse. Sections were washed in 1X PBS 3x for 10 minutes. Then, 
slices were blocked using 10% normal donkey serum (NDS) in 0.2% PBST. 
Sections were left overnight (22-24 hours) in a 1:1000 solution of primary 
Iba1 antibody (Anti Iba1, Rabbit for immunocytochemistry, Fujifilm, catalog 
#019-19741). The next day, slices were washed washed 3x in 1X PBS 
for five minutes and allowed to incubate in a 1:500 solution of secondary 
antibody (Donkey anti-Rabbit IgG, H+L, Highly cross adsorbed secondary 
antibody, Alexa Flour 647, ThermoScientific, catalog #A-31573) for two 
hours at RT. Slices were washed 3x for 10 minutes. For AD animals 
with no Methoxy-04 injections, 2000μL of CongoRed was used to wash 
sections for 3-4 minutes in order to visualize plaques. After a CongoRed 
wash, slices were washed in 1x PBS 3x for 5 minutes. Finally, slices 
were mounted on slides and stored in -20 freezer for longer term storage.

Imaging 

The Echo Revolution fluorescent microscope was used to image 
individual brain sections at 10x magnification. CY5 light intensity set at 
29% power, CongoRed at 10%. Images were saved as JPEG or TIFF 
images. A CY5, TxRed, DAPI, and merge channel were saved per slice.

Quantitative analysis of images 

Manual cell counts were obtained to quantify the number of plaques in 
the hippocampus. A standardized procedure was used to quantify microglial 
number of endpoints, branch length, and cell somas in the hippocampus. 

Plaques

The DAPI or TxRed channel was opened for quantification of plaques 
depending on whether sections were stained for plaques using Methoxy-04 
injection or CongoRed staining to visualize plaques. Each image was 
opening through Fiji (NIH) software and was adjusted according to steps 2-6 
under the Imaging and Quantification of Amyloid β Immunohistochemical 
protocol by Chirstensen A. and Pike C. J. (2021) (Christensen & Pike, 
2020). Prior to correcting the image measurements were set by selecting 
Analyze > Set Measurements > and selecting Area, Area Fraction, and 
Limit to Threshold. Once set, images were opened and regions of interest 
(ROI) were outlined using the polygon tool on Fiji and saved by double 
clicking and labeling the region outlined. In this case, the DG, CA1, and 
CA3 regions of the hippocampus were outlined. These ROIs were saved 
to be used for the remaining channels and to ensure consistency about 
the ROIs per slice. Next, the image was converted to grayscale through 
Image > Type > 8-bit. The grayscale image was converted to binary by 
selecting Image > Adjust > Threshold. At this point, the number of plaques 
were counted. In this case any apparent dark labeling on the image was 
considered to be a plaque when confirmed with the original color image. 
Once quantification was completed per region, the percentage of Aβ 
burden was calculated. To assess positive immunolabeling, the ROI was 
selected. Then, positive immunolabeling data was obtained by selecting 
Analyze > Measure. Measurements under the Area and Area Fraction 
were saved to an Excel file. Appropriate calculations were performed 
to assess the percentage of positive immunolabeled plaque burden per 
ROI. Each slice accounted for two data points, counting the left and right 
of the slice as individual points. Three dorsal and three ventral images 
were used, providing a total of six data points per slide. These data 

points were averaged pers right and left side, dorsal and ventral sections.

Microglia Morphology

Microglia morphology was assessed through sum of endpoints 
per cell and branch length per cell in ROIs information using a protocol 
established by Young K. and Morrison H. (2018) (Young & Morrison, 2018). 
A total of two dorsal images per mouse were analyzed using the protocol, 
with each image generating two data points (left and right). Each image 
was standardized using the following procedure. First, the CY5 channel 
image was opened. Then, the image was converted to black and white 
through Image > Type > 8-bit, Image > Lookup Tables > Greys. Brightness 
was then adjusted for all images through Image > Adjust Brightness/
Contrast (5-107). Microglia were better visualized through Process > 
Filters > Unsharp Mask. Background noise was subtracted using Process 
> Subtract Background. A despeckle was applied three times, Process > 
Noise > Despeckle. The binary function was closed by Process > Binary > 
Close-. Additional image noise was removed by applying Process > Noise 
> Remove Outliers with a pixel radius of 2 and a threshold of 50. Microglia 
were skeletonized using Process > Binary > Skeletonize. To analyze 
microglia skeletons, Analyze > Skeleton > Analyze skeleton was used. The 
data generated through this process was inputted into an excel sheet. The 
data was filtered by setting a minimum branch length of 8.988 µm and a 
minimum number of endpoints of 2. To get a total number of microglia cell 
bodies per ROI the following protocol was applied. First, the same CY5 
channel image was opened. ROIs were outlined using the polygon tool, 
here the hippocampus was outlined. Then Process > Subtract Background 
was applied with a rolling ball radius of 20.0 pixels. The threshold was 
adjusted using Image > Adjust Threshold (120-255). Process > Noise > 
Despeckle was applied three times. Process > Noise > Remove Outliers 
with a radius of 5.0 pixels. To get a count of cell bodies, Analyze > Analyze 
Particles for size of pixels from 200-infinity. 

Statistical Analysis

To test for significance, a two-way ANOVA was used. If 
values were significant, variables were analyzed using a Tukey 
test. Survival curves were analyzed for significance using a 
Mantel-Cox test, followed by a Grehan-Breslow-Wilcoxon test.

Results 

Chapter 1. Behavioral implications of AD and birth history in female 
and male mice

To determine the impact of AD and previous breeding history 
on anxiety-like behavior, perseverative behavior and hyponeophagia, 
or depressive-like behavior, the OF, MB, and NSF assays were used. 
Using a two-way ANOVA we compared the Tg (Control vs. AD), breeding 
history (Nulliparous vs. Parous or Sire vs. Virgin), and the interaction 
(Tg x Breeding). Although the main effects of Tg and breeding were 
not significant, F(1,26)=0.65, p=.43 (Figure 9A), there was a significant 
interaction between Tg and previous breeding history on percentage of 
time spent in the center of the OF in female mice, F(1, 26)=5.82, p=.02 
(Figure 9A). Given the significant interaction between Tg and breeding 
history, a Tukey post hoc test was carried out to determine which group 
showed statistical significance. Here, female control nulliparous mice 
trended toward a greater amount of time spent in the center of the OF 
when compared to female control parous mice, p=.08. Similar to center 
time, main effects were not observed in percentage of time spent in the 
periphery of the OF, F(1, 26)=0.54, p=.47 and F(1, 26)= 1.05, p=.31, 
respectively (Figure 9B). There was a significant interaction effect of 
time spent in the periphery of the OF, F(1, 26)=4.45, p=.04 (Figure 9B). 
However, a Tukey post hoc test did not reveal significant differences 
between the various groups. Furthermore, there were no significant 
impact of Tg, breeding history, or Tg x breeding history in the percentage 
of time male mice spent in the center of the OF, F(1, 25)=3.57, p=.07, 
F(1, 25)=2.17, p=.15, and F(1, 25)=0.0029, p=.96, respectively (Figure 
9C). Similarly, male mice did not exhibit differences in percentage of time 
spent in the periphery of the OF regardless of Tg, breeding history, and 
Tg x breeding history, F(1, 25)=2.42, p=.13, F(1, 25)=3.42, p=0.08, F(1, 
25)=.0016, p=.90, respectively(Figure 9D). Representative heatmaps for 
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female mice (Figure 9E) and male mice (Figure 9F) depict the movement 
across the OF during the OF test. Results suggest pregnancy leads to 
avoidance behaviors in the OF in control female mice. Given that male 
mice did not exhibit any differences in time spent in the center and 
periphery of the OF, this anxiety-like behavior could also indicate a sex 
difference in the impact of Tg x breeding history on anxiety-like behaviors

. 

Figure 9. Control parous female mice exhibit increased anxiety in 
the open field. A) Female control parous mice exhibit a decrease in center time 
compared to nulliparous control females. AD female mice spend similar time in the 
center regardless of breeding history (F(1, 26)=5.8, p=.0232, two-way ANOVA)(n=6-8 
mice per group). B) Time spent in the periphery was similar among the female groups, 
although the interaction was significant (F(1, 26)=4.40, p=.0447, two-way ANOVA). 
C-D) Male mice spent similar time in the center and periphery regardless of transgene 
or breeding history (F (1, 25)=0.0, p=957, two-way ANOVA); (F(1, 25)=3.805, p = 
.9011, two-way ANOVA)(n=6=13 mice per group). E-F) Representative heatmaps 
indicating movement in the OF. (n=6-13 mice per group). Error bars represent ±SEM. 
*p<0.05, **p<0.01, ***p<0.001, ****p<0.0001; OF, Open field; AD, Alzheimer’s disease.  

To evaluate perseverative and anxiety-like behavior in female 
and male mice, the number of marbles buried during the MB test were 
counted. A two-way ANOVA compared the main effects of Tg (control vs. 
AD), breeding history (Nulliparous vs Parous or Virgin vs. Sire), and the 
interaction (Tg vs. breeding history) on the number of marbles buried in 
female and male mice. The results indicate no main effect of Tg, F(1, 
26)=.19, p=.67, or breeding history,   F(1, 26)=.56, p=.46, or interaction 
between Tg and breeding history F(1. 26)=1.14, p=.30 (Figure 10A). 
Similarly, the male data also showed no main effects of Tg, F(1, 26)=.37, 
p=55, breeding history, F(1, 26)=.37, p=.55, and interaction between Tg 
and breeding history F(1, 26)=1.57, p=.22 (Figure 10B). These results 
suggest that perseverative behavior in the MB test is not affected by AD or 
pregnancy at this age. 

Hyponeophagic behavior was assessed by measuring the latency 
to approach food in an OF environment. A Mantel-cox test was used 
to determine differences in the latency to approach food in female and 
male mice Female mice showed no significant difference in the latency 
to approach food, X2(3)=1.02, p=.80 (Figure 11A). However, control sire 
male mice exhibited significantly less time to approach food after fasting 
than control virgin, AD virgin, and AD sire mice X2(3)=13.40, p=.0039 
(Figure 11B). These results suggest that prior breeding history in male 
mice might be protective against depressive-like behavior in the NSF. 

Figure 10. Marble burying is not impacted by AD or pregnancy. A) 
Female mice buried a similar percentage of marbles regardless of Tg and breeding 
history (F(1, 26)=1.1, p=.2952, F(1, 26)=.56, p=.46, two-way ANOVA)(n=6-8 
mice per group). B) Male mice buried a similar percentage of marbles regardless 
of Tg or breeding history (F(1, 26)=.37, p=55, F(1, 26)=.37, p=.55, two-way 
ANOVA)(n=6-13 mice per group). Error bars represent ±SEM. *p<0.05, **p<0.01, 
***p<0.001, ****p<0.0001; MB, Marble bury; Ctrl, control; AD, Alzheimer’s disease. 

Hyponeophagic behavior was assessed by measuring the latency 
to approach food in an OF environment. A Mantel-cox test was used 
to determine differences in the latency to approach food in female and 
male mice Female mice showed no significant difference in the latency 
to approach food, X2(3)=1.02, p=.80 (Figure 11A). However, control sire 
male mice exhibited significantly less time to approach food after fasting 
than control virgin, AD virgin, and AD sire mice X2(3)=13.40, p=.0039 
(Figure 11B). These results suggest that prior breeding history in male 
mice might be protective against depressive-like behavior in the NSF. 

Figure 11. Control sires exhibited decreased hyponeophagic 
behavior.  A) Survival analysis on female mice revealed similar time to approach 
food (X2(3)=1.02, p=.80, Mantel-cox test). B) Control sire male mice approached food 
quicker than the control virgin group, AD virgin and AD sire groups (X2(3)=13.40, 
p=.0039, Mantel=cox test)(n=6-13 mice per group). *p<0.05, **p<0.01, ***p<0.001, 
****p<0.0001; NSF, Novelty suppressed feeding; Ctrl, control; AD, Alzheimer’s disease. 

Chapter 2. The impact of breeding history and AD on cognition

Cognition was assessed using 3-shock CFC.  Freezing behavior was 
used as a proxy for memory. As expected, freezing behavior during training 
was similar in female groups, with no main effects or interactions of Tg and 
breeding history , F(1, 26)=3.03, p=.09;F(1, 26)=0.04, p=.85; F(1, 26)=0.99, 
p=.33. (Figure 12A). Similarly, there was no main effect or interaction of Tg 
and breeding on freezing behavior in male mice during the training period 
, F(1, 25)=2.45, p=0.13, F(1, 25)=0.42, p=.52.  (Figure 12B). During re-
exposure to the CFC context, there was a main effect of Tg on freezing 
behavior, F(1, 26)=5.97, p=0.022, but not breeding history, F(1, 26)=0.67, 
p=.44 or the interaction of Tg and breeding history, F(1, 26)=0.14, p=.71. 
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(Figure 12C). Male mice also exhibited a main effect of Tg on freezing 
behavior, F(1, 25)=5.0, p=.0334, but not of breeding history, F(1, 25)=0.37, 
p=.55, or from the interaction of Tg and breeding history, F(1, 25)=1.32, 
p=.26. (Figure 12D). Together, these data demonstrate that an fear memory 
is impaired in male and female AD mice regardless of breeding history.

Figure 12. AD mice exhibit cognitive decline in a CFC task. A-B) 
Female and male mice exhibit similar freezing during training (F(1, 26)=3.03, 
p=.09, F(1, 26)=0.04, p=.85, two-way ANOVA)(F(1, 25)=2.45, p=0.13, F(1, 
25)=0.42, p=.52, two-way ANOVA). C) AD female mice show less freezing 
upon re-exposure compared to controls (F(1, 26)=5.97, p=0.022, two-way 
ANOVA). D) Male AD mice also exhibited a decrease in freezing compared to 
controls  (F(1, 25)=5.0, p=.0334, two-way ANOVA).). (n= 6-13 mice per group). 
Error bars represent ±SEM. *p<0.05, **p<0.01, ***p<0.001, ****p<0.0001; CFC, 
Contextual fear conditioning; Tg, Transgene; Ctrl, control; AD, Alzheimer’s disease

To further assess the impact of pregnancy on cognition, we measured 
the correlation between freezing behavior and litter size.  The correlation 
between the total number of litters and percentage of freezing behavior in 
female mice was not significant in control, p=.11, and AD, p=.44, indicating 
no relationship between total litters and freezing (Figure 13A). Similarly, 
there was no significant relationship between total number of litters and 
freezing for male control and AD mice, p=.91 and p=.28, respectively 
(Figure 13B). In control parous females, a greater number of male pups 
was correlated with less freezing behavior, p=.05 (Figure 13C). The total 
number of male pups was not correlated with less freezing behavior in 
control male, p=.78, and AD male sire mice, p=.44 (Figure 13D). When 
the number of female pups and freezing behavior were correlated, control 
female and AD female mice did exhibit a correlation, p=.33 and p=.63, 
respectively (Figure 13E). Similarly, control male and AD sire male mice did 
not show a significant correlation between the number of female pups and 
freezing behavior, p=.36 and p=.41, respectively (Figure 13F). Together, 
these results indicate the number of litters and number of female pups does 
not have a directional relationship with freezing behavior. Interestingly, the 
number of male pups in AD parous female mice did not appear to have a 
protective impact on memory given that control parous female mice saw 
stronger fear retention memory with a lesser number of male pups. This 
finding further supports the main effect of the AD Tg on memory seen in 
the CFC test while suggesting a sex difference in fear memory retention 
(Figure 13C). 

Figure 13. A greater number of male pups correlates to better 
memory in control parous females. A) No relationship between the total 
number of litters and freezing behavior in control female (p=.11) and AD parous 
female mice (p=.44). B) Similarly, there was no significant correlation between 
total number of litters and freezing behavior in control sire (p=.91) and AD sire 
mice (p=.28). C) A lower number of male pups was correlated with better memory 
retention in control parous female mice (p=.05) but not in AD parous female mice 
(p=.63). D) There was no relationship between the total number of male pups and 
freezing behavior in control sire (p=.78). D) The number of female pups is not 
correlated with freezing behavior in control parous (p=.33) or AD parous female 
mice (p=.62). F) There was no relationship between the total number of female 
pups and freezing behavior in control sire (p=.36) and AD sire male mice (p=.41). 
(n=6-13 mice per group) *p<0.05, **p<0.01, ***p<0.001, ****p<0.0001; CFC, 
Contextual fear conditioning; Tg, Transgene; Ctrl, control; AD, Alzheimer’s disease. 

Chapter 3. Analysis of plaque pathology and microglia morphology 
in control and AD female and male mice

Plaque pathology was analyzed across the dorsal DG (dDG), dorsal 
CA1 (dCA1), and dorsal CA3 (dCA3) regions of the hippocampus in AD 
nulliparous female mice, AD parous female mice, AD virgin male mice, 
and AD sire male mice. Representative images for plaque pathology in 
female and male mice were visualized using a Methoxy-04 injection prior 
to euthanizing (Figure 14A-B). There were no main effects or interactions 
of breeding history, F(1,16)=4.37, p=.05, or sex, F(1, 16)= 0.14, p=.72, 
on the total number of plaques  in the dDG.  (Figure 14C). Plaque counts 
in the dCA1 were not significantly different after breeding, F(1, 16)=2.41, 
p=.14, or in female or male mice F(1, 16)=1.49, p=.24. Furthermore, there 
was no significant interaction on dCA1 plaque counts, F(1, 16)=0.20, 
p=.66. (Figure 14D). Additionally, there was no main effect of breeding 
history, F(1, 16)=2.55, p=.13, or sex, F(1, 16)=3.32, p=.09, along with 
no interaction of breeding history and sex in dCA3, F(1, 16)=0.22, p=.64 
(Figure 14E). Currently, these data suggest that pregnancy does not 
decrease the number of plaques significantly from that of the control 
groups in female and male mice. Size and location of plaques could differ 
but this was not analyzed. Although, there are additional plaque counts 
underway which could reveal a stronger main effect of breeding history 
in the dDG (Figure 14C) and main effect of sex in the dCA3 (Figure 14E).
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Figure 14. Plaque counts are similar across the dorsal DG, CA1, 
and CA3 regardless of breeding history. Plaque counts across the dDG, 
dCA1, and dCA3 of the hippocampus of AD nulliparous female mice, AD parous 
female mice, AD virgin male mice, and AD sire male mice were completed. A-B) 
Representative images of plaques tagged using a Methoxy-04 i.p. injection in 
female and male mice, respectively. C) There was no main effect of breeding history 
(F(1,16)=4.37, p=.05, two-way ANOVA), or sex (F(1, 16)= 0.14, p=.72, two-way 
ANOVA) in plaque count in the dDG of female and male mice. D) Similarly, similar 
plaque counts in the dCA1 show no main effect of breeding history (F(1, 16)=2.41, 
p=.14, two-way ANOVA), or sex (F(1, 16)=1.49, p=.24, two-way ANOVA). E) Plaque 
counts in the dCA3 display no main effect of breeding history (F(1, 16)=2.55, p=.13, 
two-way ANOVA), or sex (F(1, 16)=3.32, p=.09, two-way ANOVA). Error bars 
represent ±SEM. (n=2-4 mice per group). (n=2-4 mice per group) *p<0.05, **p<0.01, 
***p<0.001, ****p<0.0001; dDG, Dorsal dentate gyrus, dCA1, Dorsal Cornu Ammonis 
1; dCA3, Dorsal Cornu Ammonis 3; i.p., intraperitoneal; AD, Alzheimer’s disease. 

Immune response was measured through various microglia 
morphology such as total Iba1 labeled cell somas, endpoints per cell 
(number of branches), and branch length (µm) in the dorsal hippocampus 
of female mice. Representative images of microglia stained using an 
Iba1 primary antibody in female control nulliparous, control parous, AD 
nulliparous, and AD parous mice qualitatively show microglia features 
and location across the dorsal hippocampus (Figure 15A). Total Iba1 cell 
soma counts indicate no main effect of Tg (control vs. AD), F(1, 10)=0.21, 
p=.66, or breeding history (nulliparous vs. parous), F(1, 10)=2.03, p=.18 
on the total number of microglia in the dorsal hippocampus. Similarly, 
there was no interaction of Tg or breeding history on total number of 
Iba1 cell somas, F(1,10)=0.12, p=.73. (Figure 15B). The average number 
of branches per cell also exhibited no main effect of Tg, F(1, 10)=2.94, 
p=.12, breeding history, F(1, 10)=0.61, p=.45, or interaction between 
Tg and breeding history, F(1, 10)=0.212, p=.65 (Figure 15C). Similarly, 
there was no main effect of Tg, F(1, 10)=0.17, p=69, breeding history, 
F(1, 10)=1.01, p=.34, or interaction between Tg and breeding history, 
F(1, 10)=0.26, p=.62 on the average branch length per cell (Figure 15D). 
These data suggest that AD and breeding history do not alter microglia 
morphology in the dorsal dDG, although previous literature has shown 
that microglia morphology changes under stressful environments in 
the hippocampus (Tremblay et al., 2012; Ferrara et al., 2022). Here, it 
is important to note that additional microglia counts are underway and 
can potentially impact the significance levels observed in this paper.

Microglia morphology in male mice was assessed through total Iba1 
labeled cell somas, number of branches per cell, and branch length (µm) in 
the dorsal hippocampus of male mice. Representative images of microglia 
stained using an Iba1 primary antibody in male control virgin, control 
sire, AD virgin, and AD sire mice qualitatively show microglia features 
and location across the dorsal hippocampus (Figure 16A). Total Iba1 cell 

soma counts indicate no main effect of Tg (control vs. AD), , F(1, 12)=0.44, 
p=.52, or breeding history (virgin vs. sire), F(1, 12)=0.95, p=.35, on the 
total number of microglia in the dorsal hippocampus. Similarly, there was 
no interaction of Tg or breeding history on total number of Iba1 cell somas, 
F(1,12)=0.22, p=.65. (Figure 16B). The average number of branches per 
cell also exhibited no main effect of Tg, F(1, 12)=0.00014, p=.99, breeding 
history, F(1, 12)=0.2.52, p=.14, or interaction between Tg and breeding 
history, F(1, 12)=0.25, p=.63 (Figure 16C). Similarly, there was no main 
effect of Tg, F(1, 12)=0.42, p=.53, breeding history, F(1, 12)=0.55, p=.47, 
or interaction between Tg and breeding history, F(1, 12)=0.57, p=.46 on 
the average branch length per cell (Figure 16D). These data suggest that 
pregnancy does not alter microglia morphology in male mice, similar to 
the findings for female microglia morphology. Importantly, additional 
microglia counts are underway and can potentially impact the significance 
levels observed in the data reported here on male microglia morphology.

Figure 15. Microglial Morphology in the Hippocampus of Female Mice. 
A) Representative images of Iba1 tagged microglia in female control nulliparous (n=4), 
control parous (n=2), AD nulliparous (n=4), AD parous (n=4) mice. B) No main effect 
of Tg (F(1, 10)=0.21, p=.66, two-way ANOVA), or breeding history (F(1, 10)=2.03, 
p=.18, two-way ANOVA) on total number of microglia cell somas. C) Similar, there 
was no main effect of Tg (F(1, 10)=2.94, p=.12, two-way ANOVA) or breeding history 
(F(1, 10)=0.61, p=.45, two-way ANOVA) on the average number of branches per 
cell. D) Data on the average branch length did not exhibit a main effect of Tg (F(1, 
10)=0.17, p=69, two-way ANOVA) or breeding history (F(1, 10)=1.01, p=.34, two-way 
ANOVA). Error bars represent ±SEM. *p<0.05, **p<0.01, ***p<0.001, ****p<0.0001; 
Iba1, Ionized calcium binding adaptor molecule 1; AD, Alzheimer’s disease. 

Discussion

Aging is the greatest risk factor for neurodegeneration and 
is one of the most prevalent NDDs. The disproportional impact of 
AD on women makes it crucial to understand why women are more 
susceptible to the disease. Because women experience pregnancy 
which is a female-specific event that alters inflammation, cognition, 
and mood, this could provide insights into disease progression.

Control and AD female and male mice, without and with a 
breeding history were used to gain an understanding of disease 
progression to determine whether pregnancy and breeding can be 
protective or detrimental. Mice underwent a week-long behavior 
paradigm to understand the behavioral implications of AD and breeding 
history. Anxious behavior was measured through the OF, MB, and NSF 
tests. Furthermore, cognition was assessed through CFC analysis and 
correlation between pup data and freezing behavior. Finally, AD pathology 
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was analyzed through plaque pathology and microglia morphology.

Figure 16. Microglia Morphology in the Hippocampus of Male Mice. A) 
Representative images of Iba1 tagged microglia in male control virgin (n=2), control 
sire (n=8), AD virgin (n=4), AD sire (n=2) mice. B) No main effect of Tg (, F(1, 12)=0.44, 
p=.52, two-way ANOVA), or breeding history (F(1, 12)=0.95, p=.35, two-way ANOVA) 
on total number of microglia cell somas. C) Similar, there was no main effect of Tg (F(1, 
12)=0.00014, p=.99, two-way ANOVA) or breeding history (F(1, 12)=0.2.52, p=.14, 
two-way ANOVA) on the average number of branches per cell. D) Data on the average 
branch length did not exhibit a main effect of Tg (F(1, 12)=0.42, p=.53, two-way ANOVA) 
or breeding history (F(1, 12)=0.55, p=.47, two-way ANOVA). Error bars represent 
±SEM. *p<0.05, **p<0.01, ***p<0.001, ****p<0.0001. AD, Alzheimer’s disease. 

Anxious behavior 

To measure anxiety-like behavior, we used the OF, MB, and NSF. 
We found increased anxiety in control parous females in the OF (less time 
in the center) which suggests pregnancy could alter mood specifically in 
women. It is important to note that this is one form of avoidance behavior 
and that not all affective behaviors were measured. We don’t see this effect 
of anxiety in parous AD females, but this could be because anxiety is already 
high in AD. Previous research measuring anxiety in AD mice, indicated that 
female mice spent less time in the center of the OF as early as 5 months 
when compared to their male counterparts (Szabó et al., 2023). We did 
not see any effects of pregnancy or transgene on MB behavior suggesting 
perseverative behavior is not impacted by breeding history. At this age in 
the MB tasks we do not see differences in AD from control mice as they 
both increase (Hunsberger et al., 2024). In NSF, control sires approached 
food quickly demonstrating that males with a previous breeding history 
might be more protected against hyponeophagic behaviors (related to 
depression). A study exploring the impact of pup exposure on sire mice 
indicated that they exhibited less disrupted behavior when exploring a new 
environment (Bardi et al., 2011). These results could have translational 
value as anxiety disorders can impact one in four people, with women 
having higher incidence rates than men (Battle, 2013). Higher incidence 
rates in women could be due to the various social stress factors, changes 
in hormone levels like estrogen, and female specific events like pregnancy 
and postpartum. Notably, pregnant women are found to be more susceptible 
to mental disorders like anxiety and depression (Marquesim et al., 2016). 

Impact on Cognition

 To measure cognitive decline, we used the CFC test. We found 
both AD female and male mice showed significantly less freezing behavior 
when compared to their control counterparts, regardless of breeding 

history. As AD progresses, there can be profound changes to cognition 
due to neurodegeneration, so this was expected. Conversely, breeding 
history did not protect against this decline which we did not expect.  
Previous research in mice with breeding histories showed increased 
dendritic spine density, or plasticity in the DG, similar to what is seen in 
parous female mice (Glasper et al., 2016). Research in female rodents 
shows that breeding history improves learning and memory, although the 
molecular mechanisms which lead to this improvement are unknown (Li 
et al., 2013). Altogether, our findings in CFC do not align with previous 
studies and this could be due to many factors. Previous research did not 
use AD mice, this could indicate that pregnancy alone can not overcome 
the detrimental effects of AD. Additionally, our control mice are aged. 

Plaque pathology and microglial reactivity

To better understand the underlying mechanisms resulting in anxiety 
and cognitive decline, we analyzed plaque and microglia morphology. 
However, we didn’t observe any differences in the total number of plaques 
in the dDG, dCA1, and dCA3 in female or male mice (Figure 14). Women 
are thought to exhibit more plaque pathology than men due to changes 
in hormonal levels, which makes men less likely to develop AD due to 
their stable levels of testosterone throughout their life (Seeman, 1997). 
Additionally, previous studies have shown sex dependent differences 
in amyloid pathology. A study using AD mice reported that female mice 
had higher Aß in the brain than aged male mice (Callahan et al., 2001). 
Furthermore, pregnancy has also shown to impact amyloid plaque pathology 
(Ziegler-Waldkirch et al., 2018). In AD breeder mice, plaque number and 
size were bigger than their non-breeder counterparts (Cui et al., 2014). 
Therefore, pregnancy could play a role in maintaining plaque pathology, 
but we were not able to observe this. Potentially adding the plaque size 
measure for our data could show differences or another option is to examine 
different brain regions that could be impacted differently in breeders. 

Microglia morphology was measured through total Iba1 cell soma 
counts, number of branches, and average branch length in µm. We report 
no significant differences among female and male, control and AD mice 
regardless of breeding history (Figure 15 and 16). The accumulation of 
amyloid plaques and neuronal death are known to trigger microglia to 
their active state (Chen & Colonna, 2021). Research to investigate the 
role of microglia in the phagocytosis of plaques showed that mice which 
genetically lacked microglia led to premature lethality, indicating the 
helpful role microglia have against AD pathology (Shabestari et al., 2022). 
Furthermore, aging has shown to impact the number of microglia cell 
bodies and number of microglial branches (Godeanu et al., 2023). Why our 
study revealed little difference is unclear, but could be due to the AD model, 
we use the APP/PS1 while others use 3xTg. Additionally, this is one of the 
first studies to examine inflammation in a parous AD mouse which makes 
it hard to interpret results but also an exciting new avenue to explore. 
Many studies measure how maternal behavior impacts the offspring and 
not the mother herself, so our studies represent a new area to consider. 

Overall, our study noted significant differences in anxiety-
like behavior between female and male mice in the OF. Here, control 
parous female mice spent less time in the center when compared to 
their AD counterparts. The NSF test indicated that control sire mice had 
significantly shorter latencies to approach food when compared to control 
virgin male mice and AD virgin and sire mice. This test was indicative 
of less depressive-like behavior in the control sire mice. Furthermore, 
both AD female and male mice exhibited less freezing behavior when 
compared to the control, indicating an Tg impact. Additionally, there 
was a significant negative correlation between the number of male pups 
and freezing behavior in control female mice which should be explored 
in the future. Similarly, there were no significant differences in microglia 
morphology between female or male regardless of breeding history. 
Together, these studies demonstrate that pregnancy could impact mood 
but also in the father and that pregnancy might not be as protective as 
previously thought although future studies will confirm these results. 

Limitations 
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In this study, limitations consist of the AD mouse models, the use of 
a variable age range of mice, variable amount of litters across the groups, 
and an inconsistent n across the groups. The AD mouse model used in 
this study only shows accumulated plaque pathology, unlike other mouse 
models which can include tau tangles. Throughout the study, mice around 
the age of 7-8 months were used. The variability in the ages mice were at 
the time of euthanization depended on when mice were retired from being 
breeders. At times, some mice had additional litters after being retired, 
adding additional time to wait before running behavior testing. Additionally, 
the number of litters was not controlled for in this study. This made it so that 
some mice had anywhere between 2-9 litters. Although there were a variable 
amount of litters between the mice, this is similar to humans in the sense 
that there are unplanned pregnancies, miscarriages, and twin pregnancies. 
Ultimately, humans cannot control the type of pregnancy they experience 
or how many children they can give birth to. Additionally, while behavioral 
data is complete, there is some variability among the n used throughout 
plaque and microglia counts. Regardless, each group contained 2 or more 
mice, each with 2-4 data points from which an average was calculated from.

Future research 

From the current study, additional experiments looking at 
neurogenesis markers and inflammatory cytokines could provide a deeper 
understanding of the impact of pregnancy on the progression of AD in a 
rodent model. Additionally, ensuring that all mice are euthanized at the 
same age and have similar amounts of litters could provide better insight 
into the progression of plaque pathology and microglia morphology. Finally, 
assessing behavioral and cellular changes in young, aged, and retired 
mice could provide a holistic understanding of pregnancy in an AD model.

Note: Eukaryon is published by students at Lake Forest College, 
who are solely responsible for its content. This views expressed in 
Eukaryon do not necessarily reflect those of the College. Articles 
published within Eukaryon should not be cited in bibilographies. 
Material contained herein should be treated as personal communication 
and should be cited as such only within the consent of the author.
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